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Getting Started
Welcome to MediaWrangler!    You are about to find out just how easy
it can be to create your own interactive multimedia projects. You will
soon be able to Roundup    a wide variety of Media Elements and 
create your own design for presenting them!
There are several ways to learn your way around MediaWrangler.    
The tutorials, manual, and on-line help are designed to give you all 
the information necessary to make all your multimedia projects a 
success.
A good place to start is the Overview of MediaWrangler.    This will 
give you a good idea of the capabilities of MediaWrangler.

Click on the Open Roundup button: 
Select OVERVIEW.RDP
After the tutorial screen comes up select the Overview of MediaWrangler button.



Create a Roundup

The first step in becoming a MediaWrangler is to create a    Roundup.    At this
point you should look at the How do I Make a Roundup? tutorial.    This will 
give you an overview of creating a Roundup file.    To view the tutorial click 

on the Open Roundup button:     then select overview.rdp.    After the 
tutorial screen comes up click on How do I make a Roundup?    For a 
description of how the Roundup in the tutorial was made see: Roundup 
Tutorial 

Below is a description of how to create a simple Roundup file. 

Click on File (Alt F)

Click on New (Alt N)

Click on Roundup File (Alt R)

You will see a small window in the right hand corner of the screen.    This is 
the tree view of your Roundup. Right now it is empty.    You will need to 
import a Media Element into your Roundup.    The first media element you 
import into a Roundup must be an image (picture) file.    This is the Home 
Image    

Click on the Import/Browse Image button.  

Click on dempsey.gif

Click on O.K.

You will see a picture of a fish.    Notice that the Tree View now has a thumbnail version of 
Dempsey the Fish.

You now have created a Roundup with Dempsey as your Home Image.    This would be a 
good time to save.

Click File (Alt F)

Click    Save As (Alt A)

Type Fish and hit return or click O.K.

You now have a Roundup named Fish.    Roundups have the file extension *.RDP.    Notice the 
name is now in the caption bar of the Tree View.    You can select any image as the Home 
Image of your Roundup.

When you are creating a new roundup be sure that your Home Image is 
imported into the Roundup and not brought up as a Stray .    If you are 
importing the image be sure the Tree View    is the Active Window .    If the 
Home Image is from a Hitching Post just drag the thumbnail image into the 
tree view window.



See Also: 
Create a Hitching Post 
Create a MAP 



Create a Hitching Post

The Hitching Post    is where you keep your various Media Elements    so they 
will be close by and easy to use. If you have not already viewed the tutorial 
How do I make a Roundup? now would be a good time to do so.    The tutorial
uses an already existing Hitching Post. To view the tutorial click on the Open 

Roundup button:     then select overview.rdp    After the tutorial screen 
comes up click on How do I make a Roundup?    For a description of how the 
Roundup in the tutorial was made see: Roundup Tutorial 

Below is description of how to create your own hitching post.

Click on File (Alt F)

Click on New (Alt N)

Click on Hitching Post (Alt H)

Your Hitching Post is now active.        You can select any media element from 
any directory or disk and attach it to your Hitching Post.    To import media 
elements into your Hitching Post you will need to use one of the Import 
Media Buttons . You can also drag a media element from another Hitching 
Post or drag a Stray 

Once you have some media elements in your Hitching Post, you should save 
it:

Click on File.

Click on Save As.

Enter a name for your new Hitching Post.

Hit Return or click O.K.



Create a MAP
A MAP is a Hotspot. If you would like to see an example of how MAPs are 
used, take a look at the How do I make a Roundup? tutorial. To view the 

tutorial click on the Open Roundup button:     then select overview.rdp    
After the tutorial screen comes up click on How do I make a Roundup?    For a
description of how the Roundup in the tutorial was made see: Roundup 
Tutorial 

To make a MAP, follow these instructions:
1. Look at the Home Image    of your Roundup    and decide where 
you want to create a MAP.    Then click the right mouse button.    
Notice that the pointer changes to a pencil.    
2.    Put the point of the pencil where you want to start drawing the 
MAP, then press and hold the left mouse button. 
3.    Now move the mouse.    A rectangle will follow the mouse.    You 
can go in any direction from the point of origin and make the box 
any size as long as you remain inside the image. When you have the
box where you want it release the left mouse button.

Note:
              You can also draw free hand.    This gives you the ability to 

make MAPs of any shape,    such as tracing objects in your 
image. See: Free Hand Drawing 

4.    Single click the right mouse button to exit MAP draw mode.
Now youre ready to import a Media Element    into the MAP.    You can Drag 
and Drop    an element from a Hitching Post    file, or use one of the Import 
Media Buttons . If you want to Import Media you need to click the left mouse
button inside the MAP to make it    Active  . The MAP will highlight to indicate
it is Active.

*Note:    MediaWrangler has the ability to associate other functions with a 
MAP.    For example you can create a MAP that when you click on it the 
volume is increased, or the Autoplay roundup starts, or another application 
is launched. See: MAP Types 

See Also: The Map Tool 



Save Your Work!
Every good Wrangler knows: Save Early! Save Often!

Before you save you need to specify what you want to save.    
MediaWrangler will save the Active Window . To save a Roundup file click on 
the Tree View    Window to make it active.    To save a Hitching Post file click 
on the Hitching Post window to make it active.    Saving any image that is 
embedded in a Roundup will save the entire Roundup.

Click on File in the Menus at the top of the screen.

Click on Save    or Save As 



Open a Roundup

To open an already existing Roundup:

Click on the Open Roundup button 

Select the Roundup you wish to open.    A Roundup will have the extension 
*.RDP .

Click O.K.

*Note: You can also open a Pony Express    file from here.    Pony 
Express files have the extension *.RDZ (Roundup Zip).

See Also: Create a Roundup 



Open a Hitching Post

To Open an already existing Hitching Post:

Click on the Open Hitching Post button 

Select the Hitching Post you want to open.    A Hitching Post will have the extension *.HPF 
(Hitching Post File).

Click on O.K.

See Also: Create a Hitching Post 



MAP
In MediaWrangler, the word MAP is short for Media Area Pointer.    A 
MAP takes you to the next media element.    Its the same concept 
that some multimedia authoring systems call hot spots or buttons: 
it is the part of a picture that you click on in order to bring up 
another picture, a video clip, a piece of text, or to play a recorded 
sound.    You can make the MAP any shape and size you want, as 
long as its smaller than the picture that contains it.
*Note:    MediaWrangler has the ability to associate other functions with a 
MAP.    For example you can create a MAP that when you click on it the 
volume is increased, or the Autoplay roundup starts, or another application 
is launched. See: MAP Types 

See Also: Create a MAP 



Media Element

A media element is any picture, text, sound, or video file.    Media elements 
are the components of a Roundup .    Media elements are sometimes 
referred to as objects.

See Also: Import Media Buttons 



Drag and Drop
Drag and Drop is a commonly used technique for moving images, files, 
windows, etc.    Simply click and hold the left mouse button on an object, 
then drag the cursor to where you want to drop the object and let go. Drag 
on the caption bar of a window to move that window.



Roundup

A Roundup is a file.    Because MediaWrangler has many powerful tools and 
features a Roundup file could be most any MultiMedia Presentation:

                                  An electronic catalog
                                  A    vacation scrapbook
                                  A store window demo
                                  A multimedia    database
                                  An educational tutorial

Just to name a few!    You can make your Roundups play automatically or 
make them fully interactive; or some of both.    Roundups can have 
narrators, background music, full screen videos. MediaWrangler allows your 
imagination to be the guide!
A Roundup file (*.RDP) is a collection of pointers to Media Elements    and 
control information designed    to be organized and/or presented in a certain 
manner.    The roundup file does not actually contain the media elements. 
When a Roundup is made into a Pony Express    file (*.RDZ) the media 
element files are added to the control information to form one large file that 
contains everything.
                                                                        

See Also: 
Create a Roundup 
Open a Roundup 
The Roundup Tool 
Replacing an Image in a Roundup 



Hitching Post

The Hitching Post is where you keep your various Media Elements    so they 
will be close by and easy to use.

Hitching Posts arent connected to Roundup files in any way.    You 
can use any Hitching Post file with any Roundup file.    A Hitching 
Post is just a convenient way for you to group files that you think of 
in similar ways.    For example, you might make a Hitching Post that 
contains photographs and video clips from a particular days 
shooting, or another one that has artwork and animation you want 
to use in the same project.    Some people might make a Hitching 
Post that contains only audio files, another that contains only video 
clips, a third that contains only    photographs.    

See Also:
Create a Hitching Post 
Open a Hitching Post 
Hitching Post Options 



Tree View

The Tree View of a Roundup      gives you the ability to view your 
entire Roundup by using condensed images.    Like a tree, this 
diagram starts with a single location, the Home Image , then splits 
off to different branches containing individual elements. Image files 
will be displayed as small thumbnail-sized pictures so you can see at
a glance where each picture is connected.
If you want to save your entire Roundup under a different name use 
the Save As command while the Tree View is the    Active Window .    
The Tree View is also used to replace an image in a Roundup.
See Also: Tree View of Roundup Options 
Replacing an Image in a Roundup 



Active Window
Click on any window to make it the active window.    The active window will    
be highlighted across the top where the filename is located. This is the 
Caption bar. Only one window can be active at a time.

Click once inside a MAP to make it the active MAP.    The MAP will highlight to
indicate it is active.
*Note: If you are using images with the frames disabled you can tell which 
window is active by noting the name of the file in the status bar at the 
bottom of the screen.



Free Hand Drawing
Free Hand Drawing allows you to draw MAPs of any shape with up to 
255 points. While in Draw Map mode click the left mouse button at 
each point.    Be sure your MAP is a closed shape.    See: Map Snap 
Radius 

Select Tools (Alt T) from the Menu.
Click on Freehand Map Draw Mode (Alt F).

or:

Hit F3 to bring up The Map Tool and select Free Hand.

See Also:
The Map Tool
Create a MAP



Home Image
The Home Image is the first image in any Roundup.    The Home Image must 
be a picture file.    When an existing Roundup is opened the Home Image 
appears.
When you are creating a new roundup be sure that your Home Image is 
imported into the Roundup and not brought up as a Stray .    If you are 
importing the image be sure the Tree View    is the Active Window .    If the 
Home Image is from a Hitching Post just drag the thumbnail image into the 
tree view window.

See Also: Navigation Buttons 



The Map Tool

The Map Tool allows you to set items which control the way 
MediaWrangler draws and displays MAPs;    as well as controlling the 
Autoplay feature.

                                              Note:

When The Map Tool    is first brought up it displays the 
settings for the selected MAP, if no MAP is selected the 
default MAP settings will be displayed..    The default MAP 
allows you to draw MAPs quickly that all have the same 
characteristics.    Such as blue MAP lines, Autoplay enabled, 
5 second delay.    If you want to change the settings for a 
MAP you are about to draw make changes to the default 
MAP. 

If    you want to change the settings for a MAP you have 
already made click on the drop down arrow in the Media 
Name    box.    This will list the MAPs you have already drawn 
on the image.    A MAP is identified by the filename of the 
media element it contains.    If a MAP does not contain a 
media element it is an Unbound MAP . Select the MAP you 
want to make changes to. * Be sure to disable Use Default    
Settings when you want to make changes to one MAP and 
one Map only.

NOTE:
To see an example of how to make an Autoplay Roundup using The
Map Tool click on: Slide Show Example 
 
Below is a list of all the items contained in The Map Tool.
Click on any item for a description of that item.

Media Name 
Type

Drawing Style:

Rectangle 
Free Hand  
Map Thickness 
Color 

Options:
 
Generate Event 
Auto Display 
Preload 
Full Screen Map 

Autoplay:

Enable 
Flash MAP 



Hold Other Autoplay Until Finished 
Allow Simultaneous Playback 
Sequence in this Image 
Wait 
Use Default Autoplay Settings



Media Name
This box contains the name of the MAP you are changing the settings for.    A
MAP is identified by the filename of the media element it contains.    Click on
the drop down arrow for a list of the MAPs you have already drawn in this 
image.    If a MAP does not contain a media element it is an Unbound MAP .
*Note: A quick way to see all of the MAPs and associated information is to 
highlight this area and use the arrow keys to scroll through the list.



Type

This the type of media element the selected MAP contains: picture, text, 
sound, or video.
*Note:    MediaWrangler has the ability to associate other functions with a 
MAP.    For example you can create a MAP that when you click on it the 
volume is increased, or the Autoplay roundup starts, or another application 
is launched. See: MAP Types 



Rectangle
Allows you to draw rectangular MAPs by clicking and dragging in Draw Map 
mode.



Map Thickness
Lets you specify the thickness (in pixels) of the lines drawn when 
you create MAPs.



Color

Lets you specify the color of the lines drawn when you create MAPs.



Generate Event
Normally, playing a sound or video will not be counted as an Event .    
When Generate Event is enabled the selected media element will be 
included in the Event Count .
In the Image Control Panel, an image can be set to stay visible for (x) 
number of events.    An image MAP automatically generates an event but 
videos and audios can be made to do so when this is set.



Auto Display
Auto Display will activate the media element contained in the selected MAP 
as soon as the image containing the MAP is opened.
Auto Display will automatically execute the MAP when the image it is drawn 
on is opened.    Auto Display is unrelated to Autoplay.
For Example:

Your Roundup file is a guided tour of a house.    The Home Image is a picture 
of the front of the house.    You could have an Auto Display MAP that pops up 
a floor plan of the house.    While the user is taking the tour of the house 
they now have a floor plan to look at.



Preload
Preload tells MediaWrangler to load the media element associated with this 
MAP as soon as the image is opened but not to display it until the MAP is 
activated.
Preload will decompress an image MAP but it will not display that image until
the MAP containing it is executed.    Use this when images must be displayed
very quickly without decompression time between images.    The image will 
not stay in memory once the user is two events beyond the original image.   
To have the image stay in memory see: Image Control Panel 
For Example: 
You have an image that has three MAPs and all the MAPs are set to Preload.   
When the image is opened the elements contained in the three MAPs will all 
be loaded into memory, but none of the elements will be displayed until you
click on that MAP.

Preload allows you to display media elements quickly because they are 
already loaded into memory.    This feature is limited by the amount of 
available free memory on your system. On low memory systems this feature
could degrade performance instead of improve it. 
For more information see the Memory Management topic in Helpful Hints .



Full Screen Map

This will allow you to play    the selected video or text file full screen.    Some 
image quality may be lost depending on the type of Video Card being used 
and the CPU for your machine.



Enable
Enables the selected MAP to play automatically. See: Autoplay 
To start Autoplay:

Hit F10      or    Click on Tools , Click on Automatic Playback Start

To Autoplay in a continuos loop:

Hit    F11  or    Click on Tools , Click on Automatic Playback Loop

To stop Autoplay:

Hit F12     or    Click on Tools , Click on Automatic Playback Stop.

*NOTE:
If you are using a display that is larger than 640 x 480 
MediaWrangler will display the Autoplay Controls:

 

 

Click on one of these buttons to Start, Loop, or Stop an Autoplay Roundup.
Due to space limitations these buttons are not displayed on 640 x 480 screens.



Flash MAP

Checking this box will cause an Autoplay    
MAP to flash three times before it executes.

Example: This feature is often enabled by audio MAPs    whose 
content refers to a particular feature on an image.    If you have a 
picture of 5 people and all 5 speak, a MAP could be drawn around 
each one that plays their respective audio.    MAP Flash would 
visually indicate the speaker.



Hold Other Autoplay Until Finished
Checking this box will tell MediaWrangler to hold the next Autoplay item until 
this one has finished.    This feature is useful for videos and audios that have a 
variable length. 
Hold, Sequence, and Wait can be used to synchronize the timing of Autoplay
media elements.
*Note:
MediaWrangler allows you to play a *.MID file in the background 
while playing a *.WAV file.    This gives you the ability to, for 
example, play background music and provide narration at the same 
time. SEE: Allow Simultaneous Playback 



Allow Simultaneous Playback
MediaWrangler will allow you to play a *.MID file in the background 
while playing a *.WAV file.    This gives you the ability to, for 
example, play background music and provide narration at the same 
time.    When the selected MAP contains a Midi file, The Map Tool will 
give you this option.    Selecting this will allow a *.WAV file to be 
played while the Midi in this MAP is playing.



Sequence in this Image
Defines when the selected MAP will Autoplay    in relationship to the 
other MAPs defined for this image.    Tells MediaWrangler the order in 
which to activate the Autoplay MAPs in this image.

Hold, Sequence, and Wait can be used to synchronize the timing of Autoplay
media elements. For example: You have a set of images and each one has 
an associated audio file.    You would like each image to be displayed while 
the associated audio is playing.    Instead of timing each image to display 
when the audio is complete, simply select Hold Autoplay until Finished for 
the audio MAP.



Wait
Tells    the selected MAP how long to wait (in seconds) before starting 
Autoplay    for that MAP.    Each time is relative to the previous MAP that is 
autoplayed.
Example:    Your roundup is a tour of a house and the home image is a 
picture of the house.    You want the entryway to come up after 5 seconds, 
the kitchen to come up 3 seconds after that, and the bedroom to come up 3 
seconds after that. Simply set the delays as follows:
Entryway    : 5 seconds
Kitchen          : 3 seconds
Bedroom    : 3 seconds

Another example:    You have made a vacation scrapbook and the home 
image has the following hotspots:
      Florida - Summer 94
      Vail - Winter 95
      Wine Country - Spring 95
Each vacation has 10 images with audios that you wish to play as a slide 
show and you want each slide to play every 5 seconds with a 10 second 
delay between each vacation.    The solution is simple;    set the delay for 
each vacation to be 10 seconds and the delay for each image in the slide 
show to be 5 seconds.

Hint:    Set the default MAP delay time to be 5 seconds and let every MAP in 
the slide show use the default MAP.    Set each MAP for Florida, Vail, and 
Wine Country to not use default and set the delay for 10 seconds.



Use Default Settings

To see the default settings select Default in the Media Name    box. 

When The Map Tool    is first brought up it displays the default MAP settings 
(when no MAP is selected).    These are the current settings.    If you want to 
change the settings for a MAP you are about to draw make changes to the 
default MAP.

If    you want to change the settings for a MAP you have already made click 
on the drop down arrow in the Media Name    box.    This will list the MAPs 
you have already drawn.    A MAP is identified by the filename of the media 
element it contains.    If a MAP does not contain a media element it is an 
Unbound MAP . Select the MAP you want to make changes to.

 * Be sure to disable Use Default    Settings before making changes to the 
MAP settings if you want that MAP to behave differently than the default.



Image Control Panel

The Image Control Panel allows you to set the following items which 
control the way MediaWrangler displays a particular image in your 
Roundup:
* Note:    The settings you select will not take place until you click 
the Apply button or O.K. button.    Also, these settings do not affect 
the original image, only the way it is displayed in your Roundup.
Below is a list of all the items in the Image Control Panel. 
Click on any one for a description of that item.

X & Y Size  
Full Screen 
Preserve Aspect Ratio 
X & Y Position 
Center Image 
Flip Image Horizontally 
Flip Image Vertically 
Rotate 
Event Count 
Infinite Persistence 
Hide, Do Not Close 
Invert Colors 
Brightness Control 
Contrast Control 
Sharpness Control 
Display Effect 



X & Y Size
This lets you control the size of the image on the screen.    The    X 
and Y coordinates define the height and width of the image. Be sure 
to click on Apply for the change to take effect.



Full Screen
If you have brought up an image that is too large or too small for 
your screen this will adjust the image to fit the screen.    Be sure to 
click on Apply for the change to take effect.



Preserve Aspect Ratio
When Full Screen    has been enabled this will allow you to keep the same 
proportions for the selected image.    The default setting is enable.



X & Y Position
This lets you control the location of the image on the screen.
The X and Y coordinates define the position of the top left corner of 
the image.

* Hint!    The X & Y location control is intended for fine-tuning the 
placement of your image.    A quick way to place your image is to 
drag it to the desired location with the mouse and then click the 
PushPin button to save the location.    The arrow keys on your 
keyboard can also be used to move the image.

Be sure to click on Apply or O.K. for the change to take effect.



Center Image
This will center the selected image on the screen. Be sure to click on Apply 
for the change to take effect.



Flip Image Horizontally
Checking this box will flip the image horizontally when it is 
displayed. Be sure to click on Apply for the change to take effect.



Flip Image Vertically
Checking this box will flip the image vertically when it is displayed. 
Be sure to click on Apply for the change to take effect.



Rotate
This will allow you to rotate the image when it is displayed. Each 
time the Rotate button is pressed the image will be rotated 90 
degrees. Be sure to click on Apply for the change to take effect.



Event Count
This allows you to set the number of Events    that need to occur before the 
image will disappear.    The image may or may not be closed (removed from 
memory) when it disappears.    This will be dependent on other factors and 
settings such as position in the Roundup and the persistence settings. 



Infinite Persistence
This will allow you to keep the selected image on the screen when a 
new image is brought up.    Infinite Persistence overrides the Event 
Count .    Infinite persistence will guarantee that an image is always 
visible.



Hide, Do Not Close
This will hide the selected image when a new image is brought up, but the 
image is not closed and remains in memory.    This gives you the ability to 
return to the image quickly without having to wait for it to load again.    This 
feature is limited by the amount of free memory available on your machine.  
If too many images are stored in memory you will receive an Out of Memory 
error.    In this case you would need to close some of the images.



Invert Colors

This will allow you reverse the color scheme in the selected image.    
This is mostly used for black and white images, and will result in the 
negative image when enabled. Be sure to click on Apply or O.K. for 
the change to take effect.



Brightness Control
Move the slider to increase or decrease the brightness of the image. 
Be sure to click on Apply or O.K. for the change to take effect.



Contrast Control
Move the slider to increase or decrease the contrast of the image. 
Be sure to click on Apply or O.K. for the change to take effect.



Sharpness Control
Move the slider to increase or decrease the sharpness of the image.    Be 
sure to click on Apply for the change to take effect.



Display Effect
This will allow you display the selected image using one of the 
effects listed in the drop down list.    The effects define how the 
image will be drawn to the screen.



Event
An event occurs any time any image is brought up. Opening a Roundup 
is an event. Clicking on a MAP containing a picture is an event.    
Normally,    playing a sound or video does not generate an event 
because they do not remain on the screen.    A sound or video can be set
to count as an event by opening The Map Tool and selecting 
Generate Event.



MediaWrangler Options
The MediaWrangler Preferences dialog box allows you to set the 
following items:

Click on any item for a description of that item.

Zoom Factor 
Map Snap Radius 
Display Effect 
Prompt For Caption When Adding New Map 
Photo CD Size to Import 
JPEG Quality Factor 
Image Print Size 
Fast Print 



Zoom Factor
This value determines the amount of zooming that will be used 
when you use the Zoom In or Zoom Out menu items.



Prompt For Caption When Adding New Map

Checking this box will cause MediaWrangler to prompt you for a 
caption automatically when you add something to a new MAP. The 
caption is the name that will be shown at the top of a window when 
it is opened. It can also be automatically transferred to the 
database.



Photo CD Size to Import

Pull-down the list box to select the photo CD size for MediaWrangler 
to use when importing an image from a photo CD.
Kodak has chosen to store each image on a photo-CD in five 
different resolutions (sizes).    At the price of disk space, of which 
CDs have an abundance, the 5 resolutions allow for the highest 
quality possible at each of the 5 different resolutions or sizes.    
Resizing mathematically would degrade the quality.
In summary a Photo-CD file (*.PCD) is a file that in reality contains 5 
separate images of the same thing:
                                          Small                                                    192 x 128
                                          Medium small                          384 x 256
                                          Medium                                            768 x 512
                                          Medium large                  1536 x 1024
                                          Large                                            3072 x 2048
When using images off a Photo-CD, be sure to select    the desired 
resolution (size).    MediaWrangler uses whatever is programmed in 
the Photo-CD Size dialog box.    If you change it, it will change for all 
images. To mix and match sizes resave a particular image as a 
separate file on the hard drive.

*Warning: If you Pony Express an image from a Photo-CD, the whole 
image gets transferred (all 5 images) and this is quite large.



JPEG Quality Factor

This value determines the amount of JPEG compression to use when 
saving an image in JPEG format.    A smaller number causes more 
compression. You will have to experiment with the settings to find 
the value that gives you the best compromise between quality and 
compression for your application.



Image Print Size
This value determines the scaling factor to use when printing.
0          -    will print actual size (size of the image on the screen)
50      -    will print using half of the paper size
100 -    will print using the full paper size.



Fast Print
Checking this box result in a faster printing operation, however, you 
may lose some image quality.



Map Snap Radius
When drawing a MAP in free hand mode this value determines how 
close you must drop the final point in a MAP to the first point to 
close the MAP.    If you are having trouble closing your MAPs, try 
increasing the value.    The units for this value is number of pixels.



The Toolbar
The row of color icons across the top of the screen is the Toolbar.    
These icons give you access to a number of tools that you might use
while creating, editing, or developing a Roundup.

Below is a list of    the buttons in the toolbar;    in order from left to right.

Click on the name of any of the buttons in the Toolbar for a description of 
that button.

Close File 

Open an Existing Roundup 

Open an Existing Hitching Post 

Import or Browse Image Files 

Import or Browse Text Files 

Import or Browse Audio Files 

Import or Browse Video Files 

Show/Hide Audio Control Panel 

Show/Hide Video Control Panel 



Show/Hide Tree View of Roundup 

Navigation Buttons 

The Brand Tool 

The Search Tool

 

Set Screen Placement 

Show/Hide MAPs 



Close File 

Closes the active document.    If any changes have been made since the last 
time you saved you will be prompted to save.



Import or Browse Image Files

Allows you to Import image files into your Hitching Post or MAP. You 
can also just browse through your image files.
    

Browse:

Be sure to close all Roundups and Hitching Posts.
Click on the Import/Browse Image button.
Select the image you want to view.(See:Open Image Dialog Box ).

Double click on the filename of the image. 

or:

Click on the filename and click O.K.

When you bring up an image that is not associated with a Roundup 
file or connected to a Hitching Post it is known as a Stray . The best 
way to browse is to create a new Hitching Post and import items into
it.    Browsing is then easy and the media files are automatically 
cataloged.

Import:

Make the Hitching Post or MAP you want to import into the Active Window or
the image with the desired MAP the Active Window and select the MAP. 
*Selecting a MAP automatically makes that image the active window.

Click on the Import/Browse Image button.

Select the image you want to import. (See:Open Image Dialog Box ).

Double click on the filename of the image. 

or:

Click on the filename and click O.K.

The image is now inside the MAP or Hitching Post that was active. 

For a MAP: Double click on the MAP to bring up the Image. (Notice the cursor
changes to a camera when it is over the MAP, indicating there is an image 
there.)

For a Hitching Post: Double click on the Image.



Import or Browse Text Files

Allows you to Import text files into your Hitching Post or MAP. You 
can also just browse through your text files.    

Browse:
Be sure to close all Roundups and Hitching Posts.
Click on the Import/Browse Text button.
Select the text file you want to view.(See:Open Text Dialog Box ).
Double click on the filename of the text file. 
or:
Click on the filename and click O.K.
When you bring up a text file that is not associated with a Roundup 
file or connected to a Hitching Post it is known as a Stray . The best 
way to browse is to create a new Hitching Post and import items into
it.    Browsing is then easy and the media files are automatically 
cataloged.

Import:

Make the Hitching Post or MAP you want to import into the Active Window or
the image with the desired MAP the Active Window and select the MAP. 
*Selecting a MAP automatically makes that image the active window.

Click on the Import/Browse Text button.

Select the image you want to import. (See:Open Text Dialog Box ).

Double click on the filename of the text file.
or:
Click on the filename and click O.K.

The text file is now inside the MAP or Hitching Post that was active. 

For a MAP: Double click on the MAP to bring up the text file. (Notice the 
cursor changes to a scroll when it is over the MAP, indicating there is a text 
file there.)

For a Hitching Post: Double click on the scroll icon. You can also drag and 



drop the text file into a    MAP.



Import or Browse Audio Files

Allows you to Import Audio files into your Hitching Post or MAP. You can also just browse 
through your Audio files.    
Browse:

Be sure to close all Roundups and Hitching Posts.
Click on the Import/Browse Audio button.
Select the Audio file you want to view.(See:Open Audio Dialog Box ).
Double click on the filename of the Audio file. 
or:
Click on the filename and click O.K.
MediaWrangler plays the Audio file.
*Note: The best way to browse is to create a new Hitching Post and 
import items into it.    Browsing is then easy and the media files are 
automatically cataloged.

Import:

Make the Hitching Post or MAP you want to import into the Active Window or
the image with the desired MAP the Active Window and select the MAP. 
*Selecting a MAP automatically makes that image the active window.

Click on the Import/Browse Audio button.

Select the Audio you want to import. (See:Open Audio Dialog Box ).

Double click on the filename of the Audio file.
or:
Click on the filename and click O.K.

The Audio file is now inside the MAP or Hitching Post that was active. 

For a MAP: Double click on the MAP to play the Audio file. (Notice the cursor 
changes to a musical note when it is over the MAP, indicating there is an 
Audio file there.)

For a Hitching Post: Double click on the Audio icon. You can also drag and 
drop the icon into a MAP.





Import or Browse Video Files

Allows you to Import Video files into your Hitching Post or MAP. You 
can also just browse through your Video files.    

Browse:
Be sure to close all Roundups and Hitching Posts.
Click on the Import/Browse Video button.
Select the Video file you want to view.(See:Open Video Dialog Box ).
Double click on the filename of the Video file. 
or:
Click on the filename and click O.K.
MediaWrangler plays the Video file.
*Note: The best way to browse is to create a new Hitching Post and 
import items into it.    Browsing is then easy and the media files are 
automatically cataloged.

Import:

Make the Hitching Post or MAP you want to import into the Active Window or
the image with the desired MAP the Active Window and select the MAP. 
*Selecting a MAP automatically makes that image the active window.

Click on the Import/Browse Video button.

Select the video you want to import. (See:Open Video Dialog Box ).

Double click on the filename of the Video file.
or:
Click on the filename and click O.K.

The Video file is now inside the MAP or Hitching Post that was active. 

For a MAP: Double click on the MAP to play the Video file. (Notice the cursor 
changes to a Clapboard when it is over the MAP, indicating there is a Video 
file there.)

For a Hitching Post: Double click on the Video icon. You can also drag and 
drop the icon into a map.





Show/Hide Audio Control Panel

Displays and hides the Audio Control Panel.
The Audio Control Panel lets you control playback of existing audio files, including *.WAV and
*.MID files,    as well as giving you the ability to record your own.    To record, connect your 
microphone to the <mic> input jack on your sound card.    Then click on the record button 
and begin your recording.    When you are finished, click the stop button.    Be sure to save 
the audio file.    If you attempt to open another file MediaWrangler will notify you that you 
have an unsaved audio file.

Note:    
You may experience feedback    from the microphone through your 
computers speakers.    If this happens, use your soundcard mixer 
utility to turn off the audio output while you are recording.    Then 
turn the audio output back on to listen to your recording.
In the audio control panel there is a menu item called INFO. This can
be used to display system information concerning audio capabilities.



Show/Hide Video Control Panel

Displays or hides the Video Control Panel:
The Video Control Panel lets you control playback of video files.    



Show/Hide Tree View of Roundup

Shows/hides the structure of the selected Roundup file.    When the Tree 
View is visible, you can use it to make file operations on all the elements of 
a Roundup at once.    For example, if you have made changes to a number of
image files in the Roundup, you can save them all at once by opening the 
Tree View of a Roundup, selecting the window that contains the Tree View, 
and then selecting Save from the File menu.    Similarly, if you click the Close
button while the Tree View is active, MediaWrangler closes all elements of 
your Roundup file that are currently being displayed.    If some of these files 
have been changed since the last time you saved them, MediaWrangler 
prompts you to save the changes, discard the changes, or cancel the close.

See Also: Tree View of Roundup Options 



Navigation Buttons

 

 

Navigate along the paths of your Roundup  file.    The home button takes you to the first 
image in your Roundup; from there, the right button advances you to the next image in the 
path (this will be the image associated with the first MAP drawn on that image. To return, 
click the left button and you will back up (to the last image displayed).    If you reach either 
end of the path and try to advance, MediaWrangler informs you that you cannot proceed.

See Also: Home Image 



The Brand Tool

The Brand Tool allows you to assign keywords to Roundup files and Hitching 
Post files, including the individual media files inside each one.    
Subsequently, these keywords and dates may be used in searching the 
database.

For Example:

You sell Maseratis and Ferraris.    You make a Roundup file for each car on 
your lot.    Using the Brand tool each roundup is branded with key 
information such as: 1970 Candy-Apple Red Ferrari, five speed, mint 
condition, $150,000.    A customer is looking for a red or black Ferrari    and 
cannot spend more    than $100,000.    You search the database requesting a 
list of all red or black Ferraris that have a selling price under $100,000.    The
search results tell you that you have three cars that fit this criteria.    You can
even have search results built to a Hitching Post so you can see the 
Roundup for each car found in the search. 

It is very important to define the nature of the database you are making 
before branding it.    In doing this,    the subsequent searching will be clear to
other people.    It is worth the time it takes to just write down what you want 
to search on and what the purpose of the searching will be.    Some common 
samples of different databases are:

Real Estate -    where:        
                                                                          Keyword1 = geographical area
                                                                          Keyword2 = number of bedrooms
                                                                          Keyword3 = size
                                                                          Number        = price ($)
or

MediaManager- where:
                                                                          Caption = Phrase describing the image,
                                                                                                          sound, video, or text.
or

Office Products Catalog- where:
                                                                          Caption        = Product Name
                                                                          Keyword1 = Chair, Table, Desk...
                                                                          Keyword2 = Color
                                                                          Keyword3 = Material (wood,metal...)
                                                                          Number        = Price ($)

All files must be inside of a Hitching Post or Roundup.    If a piece of media is 
in more than one Roundup or Hitching Post, it need only be branded once.    
It is quite common to brand Roundups or Hitching Posts and not any of the 
media inside.    If a Roundup file or Hitching Post file is modified and you 
want to assign keywords to the new media elements, it must be rebranded.   
Modifications may be done in the edit/browse dialog box which can be 
accessed through the search button.



Below is a list of the items in the Brand Tool dialog box.

Click on the name of an item below for a description of that item.

Branding RDP 
Caption 
Author 
Number 
Keywords 
Keydates 
Brand/Brand All/Cancel 
First/Prev/Next/Last 



The Search Tool

Search for Roundups or individual media objects by filename, date, 
description, or user defined keywords.    Your search criteria can be 
combined by using the And/Or buttons to form complex searches.    
This simple yet sophisticated search capability makes 
MediaWrangler the ideal tool for any application which requires 
database search and retrieve capability.
You can also specify that the results of your search be included in a 
new hitching post file, by clicking on the Build Hitch button.

Click on one of the topics below for help on that topic.

Search Database 
Browse/Edit Database 



Set Screen Placement

Pin the selected image to its current location on the screen.    When 
MediaWrangler first opens an image file, you can move it by 
dragging the image by the top bar of its frame.    When you have 
placed the image where you want it in your final presentation, click 
the Set Screen Placement button and MediaWrangler will remember 
where this image file belongs.    From now on, when you open this 
image file from your Roundup, MediaWrangler displays it where you 
pinned it.    
You can change the screen placement later by moving the image 
and pinning it again, as many times as you like.    Also, note that the 
screen placement stays with the Roundup file, not with the image.    
That is, if you use the same picture in several Roundups, you can pin
the image in a different place in each Roundup.    If however, you 
use the same image in a single roundup, it will only use the 
coordinates of the last pinning.
*Note:    Do not try to pin the upper left hand corner of an image on 
a point that is not visible on the screen.    MediaWrangler will move 
the image to the visible portion.



Show/Hide MAPs

Display or hide the existing MAPs in the active window.    Use this button to 
see what MAPs you have already created in a given image.    When you 
move the cursor into a MAP, the status bar along the bottom of the 
MediaWrangler main window lets you know the filename and pathname of 
the media element associated with that MAP (if any).



Import Media Buttons
There are four Import Media buttons:

    

    

    

These buttons are used to import or browse through your various media elements.    You can 
only import into a MAP or Hitching Post    when it is the Active Window .

Click on the name of an Import Media Button for a description of that button.

Import or Browse Image Files 
Import or Browse Text Files 
Import or Browse Audio Files 
Import or Browse Video Files 



The Menus

Below is a list of the Menus located at the top of the screen.    Some of the 
items in the Menus will only be active when a Roundup is loaded.

Click on any of the Menu names below for a description of the items in that 
Menu.

File 
Edit 
View 
Tools 
Options 
Window 
Help 



File

Below is a list of the items in the File Menu.

Click on the name of an item below for a description of that item.

New 
Open 
Close 
Save 
Save As 
Print 
Print Setup 
Exit 



Edit
Below is a list of all the items in the Edit Menu.

Click on the name of an item in the Edit Menu for a description of that item.

Undo 
Delete a MAP 
Set Window Placement 
Image Description 
Import/Browse 
Redisplay 
Change Image Settings 



View
Below is a list of all the items in the View Menu.

Click on the name of an item in the Edit Menu for a description of    that item.

Show MAPs 
Hide MAPs 
Show Tree View of Roundups 
Hide Tree View of Roundups 
Go to Previous Image 
Go to First Image 
Go to Next Image 
Zoom In 
Zoom Out 
Zoom    Amount 



Tools
Below is a list of all the items in the Tool Menu.

Click on the name of an item in the Tool Menu for a description of that item.

Image Control Panel 
Map Tool 
Roundup Tool 
Automatic Playback Start 
Automatic Playback Loop 
Automatic Playback Stop 
Rectangle Map Draw Mode 
Freehand Map Draw Mode 
Search Tool 
Brand Tool 
Pony Express 
Audio Control Panel 
Video Control Panel 



Options
Below is a list of all the items in the Options Menu.

Click on the name of an item in the Options Menu for a description of that 
item.

MediaWrangler Options 
Hitching Post Options 
Tree View of Roundup Options 



Window
Below is a list of all the items in the Windows Menu.

Click on the name of an item in the Windows Menu for a description of that 
item.

Arrange Icons 
Close All 



Help
Below is a list of all the items in the Help Menu.

Click on the name of an item in the Help Menu for a description of that item.

Index 
Product Support 
About 



New

Clicking on New will open a dialog box giving you the option to create a new
Roundup,    Hitching Post, or    Text file.      Click on the type file you want to 
create.

See Also:

Create a Roundup 
Create a Hitching Post 
Create a Text File 



Open
Opens existing files.    MediaWrangler pops up the Open dialog box, 
letting you select the kind of file you wish to use, a Roundup or a 
Hitching Post.
Roundups have the *.RDP file extension.
Hitching Posts have the    *.HPF file extension.
To open other files, select the arrow at the right edge of the box 
titled List Files of Type.    This will let you choose other file types to 
open.    You can also use the Directories panel to navigate among 
your disks and directories, looking for the specific file youre 
interested in.



Close
Closes the active window, clearing its space in the editing area (and 
also freeing up the memory used to store this object).    To close an 
entire Roundup file and all its images, make sure the Tree View of 
your Roundup is visible and is active.
See Also: Close All 



Save
Clicking on Save will save any changes to the Active Window .    If the active
window is part of a Roundup, the entire Roundup will be saved.    *Hint: If you
want to save all the changes to your entire Roundup you should click on 
save while the Tree View    is the active window (this will default to the *.RDP
extension).



Save As
Clicking on Save As will save any changes to the Active Window and give 
you the option to name the file.    If you want to save all the changes to your 
entire Roundup you should click on Save As while the Tree View    is the 
active window.

Save As can also be used to change the format of a file. To change 
an image format select Save As and give the file the extension you 
wish to save it under such as *.JPG for JPEG or *.BMP for Bitmap.
When changing the format of a stray image, a new file will be 
created and the new image with the new format will be saved.    This 
file will be in focus.    When changing the format of an image inside a
roundup, a new image will be created and this new image will 
become part of the roundup, replacing the old image.



Print
The Print command will bring up the Print Dialog Box:
This box will tell you what printer you are currently connected to.    If 
you want to change to another printer select Setup.
The Print command will print the Active Window . If the active 
window contains a text file you can also select which pages to print.
Print quality is measured in Dots Per Inch.
Print To File allows you to print a text file to another directory. The 
default directory is C:\mwrangle where C is the letter of your hard 
drive.
You can also select the number of copies to be printed.



Print Setup

The Print Setup command will bring up the Print Setup Dialog Box:
This box tells you what printer you are currently connected to. To select 
another printer click on the Drop Down arrow for a list of available printers.
The print setup box also allows you to select Portrait or Landscape layout, 
the paper size you are printing to, and the type of paper feed for your 
printer.
For other available print options click on the Options button.    For help on 
options click on the Help button in the Options dialog box.
 



Exit

The Exit command will close MediaWrangler

The program prompts you to save any files that have been modified 
since the last time you wrote them to disk; you can choose whether 
to save the changes you have made, or whether to abandon them.



Undo

Erases the most recent change you made.    Useful when you were 
not quite sure what an operation was going to do, or when you 
realize you have deleted the wrong MAP. *Note: Undo will not undo a
screen placement (PushPin).



Delete a MAP
Removes a MAP from the image.    You must first select the MAP you 
wish to delete, then choose this option from the Edit menu (or hit 
the Delete key).    If you find that you have deleted the wrong MAP, 
you can replace it by selecting Undo from this menu.



Image Description
Changes the descriptive title of an image.    This is the information 
displayed in MediaWranglers status bar (across the bottom of the 
editing area).



Import/Browse

Cascades into another menu, allowing you to browse and open a 
Roundup or one the four media types (graphic, audio, video, or text)
you wish to select to associate with a MAP. 



Redisplay
Redraws an image and reinitializes the color MAPs, if necessary.



Change Image Settings

Brightness
Increases an images brightness.    Useful for correcting or retouching
the appearance of an image.    
Dim
Decreases an images brightness.    Useful for correcting or 
retouching the appearance of an image.    
Increase Contrast
Increases the contrast of the image in the active window. Like all 
image processing options in MediaWrangler, this modifies the 
images inherent settings by 10%.
Decrease Contrast
Decreases the contrast of the image in the active window. Like all 
image processing options in MediaWrangler, this modifies the 
images inherent settings by 10%.
Sharpen
Increase the sharpness of an image by filtering the graphical 
elements. Useful for correcting or retouching the appearance of an 
image.
Smooth
Smoothes (blurs) an image by filtering the graphical elements. 
Useful for correcting or retouching the appearance of an image.
Flip Horizontal
Makes a side-to-side mirror image of the contents of the active 
window.
Flip Vertical
Makes a top-to-bottom mirror image of the contents of the active 
window.
Invert
Creates a negative image of the contents of the active window.
Rotate
Rotates an image 90 degrees per iteration.



Zoom In
Lets you increase the zoom ratio of the active window.    The default zoom 
ratio is 1:1.



Zoom Out
Lets you decrease the zoom ratio of the active window.    The default zoom 
ratio is 1:1.



Zoom    Amount
Lets you change the amount of zoom when the Zoom In or Zoom Out    
command is used.



The Roundup Tool
Most of the items listed in the Roundup Tool dialog box are enabled by 
default.    Most of these items are necessary or helpful when creating and 
building a Roundup file but are not necessary when displaying a Roundup.    
In the interest of ascetics, file size, and memory some of these items may 
improve the overall quality of your roundup
For example:
You have created a Roundup that contains pictures of the new baby and you 
want to Pony Express this Roundup to the proud grandparents. If the 
roundup was designed for Autoplay you might want to enable Auto Autoplay
so that the Roundup starts playing automatically, and you might want to 
disable the Frames, Button Bar, and Status Bar so that nothing distracts 
from those precious blue eyes. 
Below is a list of all the items in the Roundup Tool dialog box.
Click on the name of an item below for a description of that item.
Auto Autoplay 
Use Window Frames 
All Images Persistent 
Enable Preload In Maps 
Include Button Bar 
Include Status Bar 
Enable Screen Scaling 
Background 



Automatic Playback Start
Starts the Automatic playback of a Roundup that has been designed for 
Autoplay. You can also press    F10.

See Also: Autoplay 



Automatic Playback Loop
Will cause a Roundup that has been designed for Autoplay to play in a 
continuous loop.    You can also press F11.

See Also: Autoplay



Automatic Playback Stop
Stops the Automatic playback of a Roundup that has been designed for 
Autoplay.    You can also press    F12.

See Also: Autoplay



The Pony Express

The Pony Express is a tool that makes distributing your Roundup 
files quick and easy. This feature compresses all the media into a 
single file called an *.RDZ (Zipped Roundup), which reduces file size 
by up to 75%.    You can choose to include with this zipped file a 
MediaWrangler Player, so the people who receive your 
MediaWrangler    Roundup file can unzip the file and play your 
multimedia presentation on their own machines.
*Note:    When Pony Expressing to floppies,    MediaWrangler will 
prompt you to insert floppy 1, 2 ... etc.    Be sure to have an 
adequate supply of formatted floppy disks available.

See Also: Pony Express Dialog Box 



Audio Control Panel
The Audio Control Panel lets you control playback of existing audio 
files, including *.WAV and *.MID files,    as well as giving you the 
ability to record your own.    To record, connect your microphone to 
the <mic> input jack on your sound card.    Then click on the record 
button and begin your recording.    When you are finished, click the 
stop button.    MediaWrangler will then prompt you for a filename to 
use to save the recording.

Note:    
You may experience feedback    from the microphone through your 
computers speakers.    If this happens, use your soundcard mixer 
utility to turn off the audio output while you are recording.    Then 
turn the audio output back on to listen to your recording.



Video Control Panel
The Video Control Panel lets you control playback of video files.    The 
controls are similar to any VCR or Tapedeck. 
In the video control panel there is a menu item called INFO. This can
be used to display system information concerning video capabilities.



Hitching Post Options
Displays the Hitching Post Preferences dialog box, allowing you to 
set options which affect the way MediaWrangler displays your 
Hitching Post.

Thumbnail Size:
This controls the size of the miniature images which are displayed in
the Hitching Post Window.

Display File Name:
Checking this box will cause the title of the media to appear at the 
bottom of its thumbnail image in the Hitching Post Window. 



Tree View of Roundup Options
The Tree View of Roundup Preferences dialog box allows you to set
the following items which control the appearance of the Tree View
Window:

Thumbnail Size:
This controls the size of the miniature images which are displayed in
the Tree View Window.

Display Image Title:
Checking this box will cause the title of the media to appear at the 
bottom of its thumbnail image in the Tree View Window. 



Arrange Icons

Arranges the icons of images that you have minimized.



Close All

Closes every open window in the editing area.
*Note:    You can not cancel a close all once it has begun.    Therefore 
if a file needs to be saved in the middle of a close,    selecting cancel
will have the same effect as selecting no.



Index
Displays the Table of Contents of the on-line help file.    From here, 
you can choose from a number of topics, or browse through the Help
files with the arrow keys.



Product Support

Describes how you can obtain customer support for questions about
MediaWrangler.



About
Displays a dialog box containing information about AltaVista 
Technology and MediaWrangler.



Set Window Placement
When MediaWrangler first opens an image file, you can move it by 
dragging the image by the top bar of its frame (or by using the 
arrow keys).    When you have placed the image where you want it in
your final presentation, click the Set Screen Placement button and 
MediaWrangler will remember where this image file belongs.    From 
now on, when you open this image file from your Roundup, 
MediaWrangler displays it where you pinned it.    
You can change the screen placement later by moving the image 
and pinning it again, as many times as you like.    Also, note that the 
screen placement stays with the Roundup file, not with the image.    
That is, if you use the same picture in several Roundups, you can pin
the image in a different place in each Roundup. *Note: An image 
used twice or more in a single roundup can only have one X,Y 
Placement.



Toggle Show/Hide MAPs

Display or hide the existing MAPs in the active window.    Use this button to 
see what MAPs you have already created in a given image.    When you 
move the cursor into a MAP, the status bar along the bottom of the 
MediaWrangler main window lets you know the filename and pathname of 
the media element associated with that MAP (if any).



Toggle Show/Hide Tree View of Roundups
Shows/hides the structure of the selected Roundup file.    When the Tree 
View is visible, you can use it to make file operations on all the elements of 
a Roundup at once.    For example, if you have made changes to a number of
image files in the Roundup, you can save them all at once by opening the 
Tree View of a Roundup, selecting the window that contains the Tree View, 
and then selecting Save from the File menu.    Similarly, if you click the Close
button while the Tree View is active, MediaWrangler closes all elements of 
your Roundup file that are currently being displayed.    If some of these files 
have been changed since the last time you saved them, MediaWrangler 
prompts you to save the changes, discard the changes, or cancel the close.



Go to Previous Image

Takes you back one image in your Roundup file.

See Also: Navigation Buttons 



Go to First Image
Takes you to the Home Image in your Roundup file.

See Also: Navigation Buttons



Go to Next Image
Takes you forward one image in your Roundup file. The forward 
image defaults to the first MAP drawn on that image (the return key 
will take you to the next image).

See Also: Navigation Buttons



Rectangle Map Draw Mode

Allows you to draw rectangular MAPs by clicking and dragging in 
Draw Map mode.
See Also: Create a MAP 



Pony Express Dialog Box

The Pony Express dialog box allows you to set the following items 
which affect Pony Express    operation:

Destination Directory:
Enter the pathname for the directory where you would like the Pony 
Express output files to be sent.
Destination Filename:
Enter the filename that you would like Pony Express to use when 
naming the compressed Roundup file.    MediaWrangler will 
automatically force the extension to be .rdz.
Include Player:
Checking this box will cause the Pony Express to include a 
MediaWrangler Player along with the compressed Roundup file.
*Note:    When Pony Expressing to floppies,    MediaWrangler will 
prompt you to insert floppy 1, 2 ... etc.    Be sure to have an 
adequate supply of formatted floppy disks available.



Branding RDP
Contains the following information about the Roundup file or Media Element 
that is being branded: the filename and directory, the name of the volume 
the file is stored on,    and the creation date.
 



Caption
This is one of the search fields for the database.    Caption could be the 
filename, a title, a descriptive phrase, etc.    This is what will be displayed in 
the caption bar for this element.



Author
This is one of the search fields for the database.    Author could be a 
salesperson, project manager, branch, department, etc.



Keywords
This is one of the search fields for the database.    Keywords are anything 
that would be useful in identification of the database record.    If the 
database contains records for cars some keywords might be the make, 
model, and color.    For houses it might be the number of bedrooms, the 
square footage, or the location.      



Keydates
This is one of the search fields for the database.    Keydates are used to 
identify database records for a certain time period.    For example you may 
want to search for records that fall between two dates such as a certain 
week or month;    or records that are before or after a certain date such as 
after January 1.



Brand/Brand All/Cancel
When you have entered all the information for a particular Roundup file or 
media element, click on Brand.    MediaWrangler will send a record of that 
file to the database and bring up the next element to be branded.    If all the 
media elements in a Roundup file will    be branded with the same search 
criteria you can click on Brand All.    Click on Cancel if you do not want to 
send a record to the database.



First/Prev/Next/Last
These buttons will be grayed out until the entire Roundup has been branded. 
After the last media element has been branded you can browse through the 
files and make changes or update the information contained in a record.



Auto Autoplay
Auto Autoplay will cause a Roundup that has been designed for Autoplay to 
start as soon as it is opened. When this is enabled, any time an image 
comes up with Autoplay enabled MAPs they will automatically start playing. 
If Auto Autoplay is not enabled use the following controls:

To start Autoplay:

Hit F10      or    Click on Tools , Click on Automatic Playback Start

To Autoplay in a continuos loop:

Hit    F11  or    Click on Tools , Click on Automatic Playback Loop

To stop Autoplay:

Hit F12     or    Click on Tools , Click on Automatic Playback Stop.

*NOTE:
If you are using a display that is larger than 640 x 480 
MediaWrangler will display the Autoplay Controls:

 

 

Click on one of these buttons to Start, Loop, or Stop an Autoplay Roundup.
Due to space limitations these buttons are not displayed on 640 x 480 screens.



Use Window Frames
Frames allow you to move image, text, and video windows by dragging and 
dropping on the caption bar.    If you are not using frames you can move the 
active window using the arrow keys.    Also text and video window size can 
be adjusted using the frame corners. To adjust the size of an image file use 
zoom or size in the Image Control Panel.



All Images Persistent
By disabling All Images Persistent you are telling MediaWrangler to close 
(remove from memory) an image that has already been displayed, leaving 
memory available for the next image. All Images Persistent should be 
disabled when you use The Pony Express. Think of All Images Persistent as 
being environmentally conscious; by closing used images you keep memory 
clear and available to other images.
All images persistent allows MediaWrangler to keep images in memory after 
they have been displayed.    This allows you to move quickly through your 
images while creating a Roundup file. If too many images are held in 
memory you will use up the available memory and receive an Out of 
Memory error. In such a case you would need to close some images to free 
up memory.
See Also: Helpful Hints (Memory Management)



Enable Preload In Maps
Preload provides a mechanism for decompressing images prior to their 
display.    This is useful when creating a Roundup file so you can display 
media elements quickly.    When an image is displayed, any image MAP that 
has Preload selected will automatically decompress.    If too many media 
elements are preloaded into memory you will use up the available memory 
and receive an Out of Memory error.    In such a case you need to disable 
Preload for some of the media elements.    Audios and videos that hold until 
complete may interfere with Preload. 

Disabling Preload will tell MediaWrangler to load a media element when the 
MAP containing it is activated. Preload should be disabled when using The 
Pony Express.



Include Button Bar
The Button Bar, located at the top of the screen,    can be hidden when your 
Roundup is loaded.    By disabling Include Button Bar you are telling 
MediaWrangler to hide the Button Bar when this Roundup file is loaded.    All 
button bar functions are also in the pull down menus, and many are 
available as hotkeys.



Include Status Bar
The Status Bar, located at the bottom of the screen,    can be hidden when 
your Roundup is loaded.    By disabling Include Status Bar you are telling 
MediaWrangler to hide the Status Bar when this Roundup file is loaded.



Enable Screen Scaling
Enable Screen Scaling tells MediaWrangler to adjust the size of the images 
being displayed so they fit the screen.    This allows a Roundup to be played 
on different size monitors.    MediaWrangler will automatically adjust the 
position of images when a Roundup is displayed at different monitor 
resolutions.    Because images degrade when they are resized, 
MediaWrangler does not attempt to change the image size.    By selecting 
Scale to Screen, you are instructing MediaWrangler to resize the images.    
This may be fine when sending *.RDZs (zipped Roundups) to customers, 
friends, and clients;    but, if you are editing a Roundup on different machines
with different resolutions the continuous resizing of the images may 
adversely affect the image quality.    In summary, only use this option at the 
end of a project just prior to distribution.
*Note: If a scaled image has MAP size and locations that do not appear 
correct, go into the Image Control Panel and select Full Screen, then return 
the image to the previous location.    This will fix the incorrect MAPs.



Background
Allows you to choose the background color that will be displayed when your 
Roundup file is loaded.



Search Database

Click on the box to the left of any of the search criteria boxes to include that 
item in your search.    Each of the search criteria boxes has a drop down list 
giving you choices for that box.    You can also select how to apply the search
criteria with the And/Or option.

Below is a list of the items in the Search Database dialog box.

Click on the name of an item below for a description of that item.

Caption 
Author 
Keywords 
Dates 
Number 
File Info 
Search Results 



Browse/Edit Database
After a Roundup and the media elements associated with it have been 
branded you can browse through the records and make any changes or 
updates.    The browse/edit dialog box can also be reached from The Search 
Tool.

Below is a list of the items in the Browse/Edit dialog box.

Click on the name of an item below for a description of that item.

Browse/Edit 
Caption 
Author 
Number
Keywords 
Keydates 
Update/Delete/Done 
First/Prev/Next/Last 
Show Contents 



Dates

Can be used to narrow your search to a specific time period.    You can use 
the Creation Date or Keydates that were entered when the item was 
Branded.



File Info
Information about the file you are searching for can be used as criteria in 
your search.    For example:    Search for all the Bitmap files by using the 
*.BMP extension in the Format box.



Search Results
The results of your search will be listed in the Search Results box.    You can 
choose Ascending or Descending order for the list.
Continue Search:
This allows for continued searching to be performed based on the 
results of the first search.    For instance, the first search may find all 
of the images in the database (searched on type).    Clicking on 
continue search will cause all of the fields to be updated with image 
specific information therefore only the captions associated with 
images are visible under the Captions pull down.



Browse/Edit
After a Roundup and the media elements associated with it have been 
branded you can browse through the records and make any changes or 
updates.    The browse/edit dialog box can also be reached from The Search 
Tool.

This area lists the name and directory of the current record, the name of the
volume that holds the record, and the date it was created on.



Number
This is one of the search criteria for the database.    Number could be a stock
number, invoice number, dollar amount, etc.



Update/Delete/Done
If you have changed the contents of a record in the database you will need 
to click on update for the changes to be saved.    Delete will remove a record
from the database.    Click on Done to exit the Edit/Browse Database mode. 



Show Contents
If the selected record is a Roundup (*.RDP) or a Hitching Post (*.HPF)
clicking on the show contents box will list the individual elements of 
that file. 



Open Image Dialog Box

When you select the Import/Browse Images button, a dialog box that
asks you to make the following selections will pop up:

Directories:
You can choose one of the folders in the Directories window (in the 
middle of the dialog box) to select the directory in which the desired 
image file is stored.    You can also browse through directories this 
way.
File Name:
By default, selecting the Browse Images button preloads the File 
Name field with *.*, indicating that MediaWrangler will look for 
images of all formats. To look only for images of a specific type such 
as bitmaps (with an extension of .BMP) or JPEG-compressed images,
enter the extension indicating the kind of image you wish to look for 
in the File name field or select one from the List Files of Type field at 
the bottom left of the dialog box.
Below the File Name field is a scrolling display containing all the files
that match the file name specification.    
When you have selected the image file you want, click OK.    
MediaWrangler opens the image file and displays it on the screen or 
imports it to the MAP or Hitching Post that was active.    (You can also
double-click on the file name to open it.)
The media element buttons also let you associate the selected 
media element with an existing MAP that you have already added to 
your Roundup file.    To associate an image file with an existing MAP, 
select the MAP by clicking on it once with the left mouse button.    
Then open the image file as described here.    MediaWrangler now 
associates this image file with the MAP you selected; when you 
double-click on the MAP, MediaWrangler opens the image file.
If you have a Hitching Post file active, MediaWrangler adds the 
media element to the Hitching Post, displaying a thumbnail of the 
files contents.    This can simplify browsing and adding this media 
element to other Roundups later on.



Open Text Dialog Box
When you select the Import/Browse Text button, a dialog box that 
asks you to make the following selections will pop up:
Directories:
You can choose one of the folders in the Directories window (in the 
middle of the dialog box) to select the directory in which the desired
text file is stored.    You can also browse through directories this way.
File Name:
By default, selecting the Browse Text button preloads the File Name 
field with *.txt and *.doc, indicating that MediaWrangler will only 
look for files of these two types. You can also select a different file 
type if you wish; just enter the extension indicating the kind of file 
you wish to look for in the File name field or select one from the List 
Files of Type field at the bottom left of the dialog box.
Below the File Name field is a scrolling display containing all the files
that match the file name specification.
When you have selected the text file you want, click OK.    
MediaWrangler opens the file and displays it on the screen.    (You 
can also double-click on the file name to open it.)
The media element buttons also let you associate the selected 
media element with an existing MAP that you have already added to
your Roundup file.    To associate a text file with an existing MAP, 
select the MAP by clicking on it once with the left mouse button.    
Then open the file as described here.    MediaWrangler now 
associates this file with the MAP you selected; when you double-
click on the MAP, MediaWrangler displays the text.
If you have a Hitching Post file active, MediaWrangler adds the text 
file to the Hitching Post, displaying a text icon.    This can simplify 
browsing and adding this media element to other Roundups later on.



Open Audio Dialog Box
When you select the Import/Browse Audio button, a dialog box that 
asks you to make the following selections will pop up:

Directories: You can choose one of the folders in the Directories 
window (in the middle of the dialog box) to select the directory in 
which the desired audio file is stored.    You can also browse through 
directories this way.
File name: By default, selecting the Browse Audio button 
preloads the File Name field with *.wav and *.mid, indicating that 
MediaWrangler will look for standard wave files and MIDI files. You 
can change the kind of file you want MediaWrangler to search for: 
just enter the extension indicating the kind of file you wish to look 
for in the File name field or select one from the List Files of Type field
at the bottom left of the dialog box.
Below the File Name field is a scrolling display containing all the files
that match the file name specification.    
When you have selected the sound file you want, click OK.    
MediaWrangler opens the file and plays it.    (You can also double-
click on the file name to open it.)
The media element buttons also let you associate the selected 
media element with an existing MAP that you have already added to
your Roundup file.    To associate an audio file with an existing MAP, 
select the MAP by clicking on it once with the left mouse button.    
Then open the audio file as described here.    MediaWrangler now 
associates this audio file with the MAP you selected; when you 
double-click on the MAP, MediaWrangler plays the audio file.
If you have a Hitching Post file active, MediaWrangler adds the audio
file to the Hitching Post, displaying a audio icon.    This can simplify 
browsing and adding this media element to other Roundups later on.



Open Video Dialog Box

When you select the Import/Browse Video button, a dialog box that 
asks you to make the following selections will pop up:

Directories: You can choose one of the folders in the Directories 
window (in the middle of the dialog box) to select the directory in 
which the desired video file is stored.    You can also browse through 
directories this way.
Below the File Name field is a scrolling display containing all the files
that match the file name specification.    
When you have selected the video clip you want, click OK.    
MediaWrangler opens the file and plays it.    (You can also double-
click on the file name to open it.)
The media element buttons also let you associate the selected 
media element with an existing MAP that you have already added to
your Roundup file.    To associate a video file with an existing MAP, 
select the MAP by clicking on it once with the left mouse button.    
Then open the video file as described here.    MediaWrangler now 
associates this video file with the MAP you selected; when you 
double-click on the MAP, MediaWrangler plays the video file.
If you have a Hitching Post file active, MediaWrangler adds the video
file to the Hitching Post, displaying a video icon.    This can simplify 
browsing and adding this media element to other Roundups later on.



Autoplay
Autoplay lets you set up a presentation that runs automatically, 
without user intervention.    For example, if you wish to set up a slide 
show that runs by itself at a trade show booth, an information kiosk, 
or in the window of your store or office, you can use Autoplay.    The 
Autoplay feature can be used on Roundups that you have already 
made.    In addition, MediaWrangler allows a presentation to be half 
interactive and half automatic, for example:    Press a button and see 
a slide show.
Controlling the amount of time that MediaWrangler waits before 
beginning Autoplay for an individual media element lets you 
synchronize the display of images with a sound track.    For example, 
you can start playing an audio file that contains the narration, then 
use the Wait value to make sure that pictures appear on the screen 
when the narrator is talking about them.
How to Create an Autoplay Roundup file:
First create a Roundup and MAP:
Click on File, New, Roundup

Click on Import/Browse Image 
Click on Dempsey
Draw a MAP. For this example, make a small MAP around the eye. Click on the MAP to make 
it active. The MAP should be highlighted.
Next you need to import a media element. For this example, import an Audio file:

Click on Import/Browse Audio 
In the Drives box click on the Drop Down arrow to list the drive choices for your machine.   
Select your CD-ROM Drive.    

Double Click on mwrangle
Double Click on audio
Double Click on miscwav
Double Click on wav002.wav
Now would be a good time to save your Roundup. Click on File, Save
As.    Call your Roundup water.

Now that you have created your Roundup it is time to make it 
Autoplay.    Click on the MAP to make it active.
Click on Tools, Map Tool
The Media Name box should say wav002.wav
Click on the Use Default Settings box to disable it
Under Autoplay click on the Enable box
Click on O.K.



Now save your Roundup then close it.    Your Autoplay Roundup is 
ready.    When you open the roundup again it will be ready for 
Autoplay.    You can set your Roundup for Auto Autoplay    so that it 
starts automatically or you can start it yourself:
To start Autoplay:

Hit F10      or    Click on Tools , Click on Automatic Playback Start

To Autoplay in a continuos loop:

Hit    F11  or    Click on Tools , Click on Automatic Playback Loop

To stop Autoplay:

Hit F12    or    Click on Tools , Click on Automatic Playback Stop.

*NOTE:
If you are using a display that is larger than 640 x 480 
MediaWrangler will display the Autoplay Controls:

 

 

Click on one of these buttons to Start, Loop, or Stop an Autoplay Roundup.
Due to space limitations these buttons are not displayed on 640 x 480 screens.

See Also: Slide Show Example 



Stray
A stray is a media element that has been imported without being 
attached to a MAP.      A stray cannot contain a MAP.    A common 
place to group strays is on a Hitching Post.
If you want to import a stray into a MAP or Hitching Post simply 
place the cursor on the stray image, hold the left mouse button 
down and drag the cursor to the desired MAP or Hitching Post.    Note
that the cursor turns to a lasso when you are dragging.



Unbound MAP
An unbound MAP is a MAP that does not contain a media element. 
The cursor looks like an empty box when it is over an unbound MAP.  
See Also: MAP Types 



The Keyboard
A number of MediaWrangler commands are available from the 
Keyboard.    The following is list of the available keyboard 
commands.    Some of these commands are available only when the 
applicable item is active.
The Function Keys:
F1    -    Brings up MediaWrangler Help
F2    -    Brings up the Image Control Panel
F3    -    Brings up The Map Tool
F4    -    Brings up The Roundup Tool
F5  -    Show/Hide MAPs
F6    -    Show/Hide Tree View of Roundup
F7    -    Push Pin (sets image placement)
F8    -    Brings up the Audio Control Panel
F9    -    Brings up the Video Control Panel
F10-    Start an Autoplay Roundup
F11-    Play Autoplay Roundup in a continuos loop
F12-    Stop an Autoplay Roundup
Other Keyboard Commands:
The arrow keys can be used to move images and videos.    For a text
file use ALT and the arrow keys.
Return (Enter) will take you to the next image in a Roundup.
Home will take you to the Home Image of a Roundup.
Backspace will take you to the previous image.
Any of the menu commands can be reached through the keyboard: 
hold the ALT key and hit the underlined letter of the command.    For 
example,    ALT F, S will save your file.    ALT T, M will bring up The 
Map Tool.



MAP Types

In most cases a MAP will be associated with a picture, sound, text, or
video file.    MediaWrangler can also associate a MAP with a number 
of functions. Below is a list of all the items that can be associated 
with a MAP.
Image
Audio
Video
Text
Roundup
Exit MediaWrangler
GoTo Next Image
GoTo Home Image
GoTo Previous Image
Print Current Image
Print Current Text
Launch Application
Autoplay Start
Audio Load
Audio Play
Audio Stop
Audio Rewind
Audio Forward
Audio Loop
Audio Pause
Audio Volume Up
Audio Volume Down
Audio Record
Video Load
Video Play
Video Stop
Video Rewind
Video Forward
Video Loop
Video Pause
Video Volume Up
Video Volume Down
WWW File Transfer (for HTML documents only)
WWW E-Mail (for leaving a message in HTML docs only) 

To associate one of these functions with a MAP: select the unbound 
MAP you want to use. Select The Map Tool.    In the TYPE box click on 
the drop down arrow for a list of the available MAP types.



Replacing an Image in a Roundup
Sometimes you need to replace an image that is embedded in a 
Roundup.    To do so simply bring up the Tree View and drag the new 
image onto the old image in the tree view.    You can bring the new 
image up as a stray or drag it from a hitching post.    
*Note:    This will work for any image including the Home Image. If 
the image you are replacing contains MAPs be sure that you replace 
it with an image that is at least as large as the old one so that the 
MAPs are contained.



Slide Show Example

To make a Slide Show first make a Hitching Post of the items you 
want to include in your Slide Show. Next create a Roundup using the 
first slide you want to show as the Home Image.

Now bring up The Map Tool and configure the default MAP to be: 
              Autoplay Enable
              Delay 5 seconds
Then draw a MAP on the home image and drag the second image 
into it from the Hitching Post.

Double click on the MAP to bring up the second image.    Now draw a 
MAP on the second image and drag the third image into it. Repeat 
for each image.
Your Slide Show will now play. 

To change the delay select the default MAP by hitting F3 with no 
MAPs active and change the delay to 10 seconds.

To start Autoplay:

Hit F10      or    Click on Tools , Click on Automatic Playback Start

To Autoplay in a continuos loop:

Hit    F11  or    Click on Tools , Click on Automatic Playback Loop

To stop Autoplay:

Hit F12     or    Click on Tools , Click on Automatic Playback Stop.

*NOTE:
If you are using a display that is larger than 640 x 480 
MediaWrangler will display the Autoplay Controls:

 

 

Click on one of these buttons to Start, Loop, or Stop an Autoplay Roundup.
Due to space limitations these buttons are not displayed on 640 x 480 screens.



Create a Text File
To create a new text file click on File, New, Text (Alt F,N,T)
A window will pop up. You can now add text to this window and save 
it as you would any file.



Roundup Tutorial
The Roundup described in the tutorial is relatively simple to create.   
The ideas used are common to many types of Roundups.    Below is a
description of how to make it.

Click on Open Hitching Post 
Select realhp.hpf

Click on File, New, Roundup
Drag realroot.jpg out of the hitching post and drop it into the tree view. This makes it your 
home image.

Draw a small MAP in the lower left hand corner of your home image.
Drag rnr.wav out of the hitching post and drop it into the MAP.

Draw a MAP around the front door.
Drag realenty.jpg out of the hitching post and drop it into the MAP.

Draw a MAP around the window on the lower left.
Drag realwin1.jpg out of the hitching post and drop it into the MAP.

Draw a MAP around the window on the upper right.
Drag realwin2.jpg out of the hitching post and drop it into the MAP.

Click on the Show/Hide MAPs button: 

Now would be a good time to save your roundup and give it a name.
You are ready to fine tune the roundup and give it the features you 
want.
First arrange your images.    Double click on the front door to bring 
up the image of the entryway.    You can move the image by 
dragging it or by using the arrow keys.    Place the image where you 
would like it to come up when the roundup is played and click on the

PushPin button:     Repeat this for each image.

Press F3 to bring up The Map Tool (ALT T,M).
Set the default MAP to:    Autoplay enable, flash MAP enable, delay 5 seconds. 

Press F4 to bring up The Roundup Tool (ALT T,R).    Enable Auto 
Autoplay, disable the button bar, the status bar, and image frames. 

Save and close your roundup.    When you open it again it will play 
automatically using the features you selected.    If you want to 
experiment with other features you should disable Auto Autoplay (in 
The Roundup Tool). You could experiment with different color MAPs, 
a different color background, or not flashing MAPs.    You could alter 
the appearance of the images by using the Image Control Panel. You 
could change the features of just one MAP or all of them. You could 
change the order in which the images appear.



MediaWrangler has a large number of features and tools; simply use 
your imagination!



Helpful Hints
Memory Management Hints
As is the way with computers memory is a valuable commodity.    
Proper management of the available memory on your machine can 
be used to create dynamic presentations.    Media Elements vary a 
great deal in file size, and of course (with some exceptions) the 
higher quality media elements will be the larger file sizes, thus use 
more memory.    The creators of MediaWrangler are aware of the 
value of memory and have given you a number of tools for memory 
management.    Preload, Hide Do Not Close & Persistence are all 
useful tools for maximizing what you can do with the available 
memory on your machine.    The use of these tools, along with the 
type of MAPs used, type of Media Elements used, and the 
arrangement of MAPs within your Roundup will affect the overall 
performance of your Roundup files.
Normal Operation
All images must be decompressed, which takes time, and all 
decompressed images must occupy memory, which is expensive 
and usually in short supply.    MediaWrangler has instituted a unique 
management algorithm that attempts to optimize this age old trade 
off between time and money.    It is called Generational Memory 
Management (GMM) because the program decides when to discard
an image from memory based on its generation.    Consider the 
home image to be the parent, and all of the image MAPs on it are 
first generation children.      These children may have children of their
own who in turn may have children of their own and so on.    
MediaWrangler releases an image from memory when an 
image that is two generations from it (either direction) 
becomes visible.    This is the default behavior of the program.    
However, MediaWrangler provides three simple overrides that allow 
the user to customize a roundup. 
Persistence
An Image is said to be persistent if it remains on the screen.    If an 
image is persistent, it is taking up memory therefore the Roundup 
Tool option Always Persistent should be used with caution.    
Normally, this option is only checked during Roundup creation and is
left unchecked in roundups that are to be distributed.      If selected 
images are to remain visible, they should have their persistence set 
in the image control panel.    

Preload 
Every image must be decompressed before it can be displayed.    
However an image can be decompressed and not be visible on the 
screen.    Because decompression is necessarily time consuming, 
MediaWrangler allows the user to specify when an image should be 
decompressed.    The most common and therefore the default is to 
let MediaWrangler decompress an image immediately before 
displaying it on the screen.    However, when an image becomes 
visible, MediaWrangler checks every image MAP on that image to 
see if Preload has been set.    If an image MAP is set to Preload, it will



immediately decompress but it will not become visible until the MAP 
is executed (clicked with the mouse or autoplayed).
Hide do not close
This option will allow an image to remain in memory after it is 
decompressed, by whatever means, although the amount of time it 
remains visible will be determined by its persistence setting. 

Audio Hints
If you attempt to play an audio while you are playing a video, the 
audio will not cut in and it will default to no sound card and never 
play again.
The volume slider in the Audio Control Panel does not take effect 
until the slider is released.

On some machines excessive use of the Volume slider can cause the
system to lockup.

Starting a .WAV file and .MID file at exactly the same time will cause 
a conflict with some sound cards.    In most cases a 2 second delay 
on one of the files will correct this.

Video Hints
When you view a video using the Full Screen feature, do not pause.
If you hit pause you cannot get the Video Control Panel back in 
focus.
If you attempt to play an audio while you are playing a video, the 
audio will not cut in and it will default to no sound card and never 
play again.
The volume slider in the Video Control Panel does not take effect 
until the slider is released.
On some machines excessive use of the Volume slider can cause the
system to lockup.

Image Hints

If you place an image on the screen where you cannot get to the 
caption bar to move it, you can use the arrow keys to move it.

To change an image format select Save As and give the file the 
extension you wish to save it under such as *.JPG for JPEG or *.BMP 
for Bitmap.

When changing the format of a stray image, a new file will be 
created and the new image with the new format will be saved.    This 
file will be in focus.    When changing the format of an image inside a
roundup, a new image will be created and this new image will 
become part of the roundup, replacing the old image.
Some CYMK images created in Adobe Photo Shop will cause a Divide
by Zero error in Windows.



Sometimes when you display an image the window will come up 
blank (white).    This is caused by a shortage of memory. In most 
cases simply closing the file and opening it again will remedy this. 

Creating Roundups for different size monitors

MediaWrangler will automatically place images at the right spot 
when a Roundup is transferred to a different size monitor.    The size 
of the images will not change because the quality will degrade.    For 
the best results, use images that will fit, i.e.: not to big, on small 
monitors.    If you feel it is important to resize the images based on 
the size of the monitor, select Enable Screen Scaling in the Roundup 
tool.    Repeated scaling will cause an irreversible degradation of 
quality. 

Miscellaneous Hints
When using Close All and you are given the option to Save, using 
the Cancel option is the same as saying No.    The cancel button will 
not revert to before the command was used.
The Undo command will not undo an image placement (PushPin).    
Undo will bring back a MAP that has been deleted.    

When you flip and rotate an image you should flip first and then 
rotate.    

When image changes are saved in a stray a new file is created with 
the changes.    When image changes are saved in a Roundup they 
are saved to the Roundup and not to the image.

When using the MediaWrangler Player, if you play a Roundup that 
does not display the button bar and the Roundup cannot find an 
image, ESC is all you can do.
You can use nosound.wav to generate an event that will eliminate 
an event.    For example, if you want the last image in a slide show to
remain visible for 10 seconds then close, set the MAP for the image 
to have a persistence of one event, then set the MAP for 
nosound.wav to generate an event and autoplay after 10 seconds.
If an image is in a Roundup and in memory (even if it is not 
displayed) you cannot separately display the stray of that image.
MediaWrangler cannot Pony Express text files that are open in a 
Roundup.    The text files need to be closed before using the Pony 
Express.



Frequently Asked Questions

Q:      How do I keep the Hitching Post in focus on a small screen?
A:      At times (especially on smaller screens) bringing up an image 
will hide the Hitching Post.    The quickest way to bring your hitching 
post back into focus is to click on Window in the menus and click on
the Hitching Post.    A Hitching Post file will have the (*.HPF) 
extension.
Q: I tried to display an image and the window came up blank 
(white). Whats wrong?
A: This is caused by a shortage of available memory.    In most cases 
simply closing the file and opening it again will remedy this. 
Q: I ran setup.exe to install MediaWrangler, but nothing happened. 
Whats wrong?
A: If you have several applications already running on your 
computer, there may not be enough memory available to load the 
installation program.    (For instance, you may have a word processor
or spreadsheet running, even though it only appears as an icon.) Try
quitting some or all of the applications and run setup.exe again.
Q: MediaWrangler displays my images, but they dont look right.    
Whats the problem?
A: You may need to change the display mode of the video adapter 
card in your computer.    For instructions on how to do this see 
Setting up your Video Adapter Card .    There may also be a palette 
conflict with other applications.    Try exiting all other programs and 
try again.
Q: The MediaWrangler button is grayed out.    Why?
A: The buttons available on the MediaWrangler button bar change 
depending on the type of window that is active.    The active window 
will have a blue caption bar.    The other windows will have a white 
caption bar.    Try clicking on the different types of windows (Hitching
Post, Image Window, Tree View of a Roundup, etc.) to see the 
different combinations available on the button bar and menus.
Q: I created a new MAP and tried to import an audio file to it.    The 
audio played, but no association was made between the MAP and 
the audio file.    Why not?
A:    You must first select the MAP by clicking once with the left 
mouse button before you can use an Import/Browse button to add 
media to it.    If you do not first select the MAP, the Import/Browse 
buttons are in the browse mode, and simply displays the image or 
text or plays the audio or video that you select, without attaching it 
to the MAP.    
Tip: If you drag an object from the Hitching Post or Windows

File Manager to make an association, you do not have to
select the MAP first.    Selecting the MAP is only required
when using the Import/Browse buttons to add media to a

MAP.



Q: How do I use MediaWranglers JPEG compression capability to 
shrink the size of images in my Roundup?
A: Under the Options menu, select the MediaWrangler Preferences 
option.    In the dialog box that appears, select the JPEG compression
value that has the setting you desire.    (You will have to experiment 
with the settings to find the value that gives you the best 
compromise between quality and compression for your application.) 
Open a Roundup and display the image you wish to compress.    
Select the Save As item from the File menu.    A dialog box 
appears; enter the name and directory to which you wish to save 
the image.    Use a file name that ends with the extension .JPG and 
click OK.
Q: I copied a Roundup directory and file to another location, but now
I cant view it.    Whats wrong?
A: Roundups contain several pieces of information, including the 
pathnames of each piece of media.    If you copy these files to a new 
location, MediaWrangler may not be able to read them.    Try using 
the Pony Express feature to move the Roundup.    If you Pony 
Express a Roundup to a new destination on your hard drive, you 
may then move the resulting *.RDZ file anywhere you like, and 
MediaWrangler will be able to read it.
Q: Why do my sound card and speakers howl when I try to record 
with MediaWrangler?
A: This howl is known as feedback.    It is usually caused by having 
the speakers too close to the microphone.    Try pointing the 
speakers away from the microphone, or place them behind your 
monitor with the microphone in front of it.    If this doesnt help, try 
using the audio mixer software that comes with most audio cards; 
turn off your audio output while you are recording, then turn it back 
on to hear what you have recorded.    (Or as a simpler alternative, 
unplug your speakers till you have finished recording.)
Q: I made an audio recording, but when I play it back I dont hear 
anything.    Why?
A: Your microphone may be turned off or unplugged.    Use the mixer 
software that came with your sound card to turn on the microphone 
input of your sound card, then try again.
Q: How can I install MediaWrangler if I dont have a CD-ROM drive?
A: Call AltaVista and order a set of installation floppies.    There is a 
minimal fee to cover the shipping and handling.
Q: Why do I see the camera icon in the Tree View of a Roundup 
instead of the thumbnail view of my media?
A: If MediaWrangler cannot locate the thumbnail of the media, it will 
display the camera icon.    





Setting up your Video Adapter Card

The following information is meant to help you set up your video 
card to work correctly with MediaWrangler.    If you have a VGA video
card, which is limited to display only 16 colors at a time, you will 
almost surely experience less than desirable image quality.
AltaVista recommends that you upgrade to an SVGA card, which 
offers multiple options for the number of colors and resolutions 
which you can display.    If you already have an SVGA card and your 
images still dont look right, you may not have your video card in the
correct mode.    Follow these steps to check or modify your video 
card settings.
If your video card came with a Windows software program that 
allows you to change the video card settings, try running that 
program.    You can often find such a program in the Windows control
panel.
1.    From the program manager, open the Main group.
2.    Double-click on the Control Panel icon.
3.    If you have a video card icon, double-click it to start the 
program.
4.    Change the settings to provide 256 or more colors.    You may 
need to buy more memory for your video card to run with the 
highest possible number of colors,    However, you should see good 
results using the 256-color mode of your video card.
5.    You will now need to quite and restart Windows for the change 
to take effect.

If your video card did not come with a software utility for changing 
the settings, follow these steps:
1.    Exit Windows.
2.    Change to the Windows directory by entering the following 
command:

>chdir \windows
3.    Now enter the following command:

> setup

This starts the Windows setup program.    Using the arrow keys, 
select the item that reads Display, then press the Enter key.
Now, you can select a different setting or driver to use with your 
video card.    If the driver has not been installed on your computer, 
you will have to insert the floppy that contains your video card 
software, and load the new driver from it.    The setup program will 
prompt you to do this.

Select a driver that has 256 or more colors.    You may have several 
resolutions to choose from as well for example, 648 x 480, 800 x 
600, 1024 x 768, etc.    Experiment and find a combination that you 



like; AltaVista recommends 640 x 480 and 256 colors as a minimum.
If you are still having trouble with your video card settings, call the 
technical support line provided by the manufacturer of your video 
card and ask for assistance.
If you are still having difficulty, call AltaVista technical support.

AltaVista Technology
1671 Dell Avenue, Suite 209
Campbell, CA    95008
Phone: 408-364-8777
Fax: 408-364-8778



Beginners Tutorial
The MediaWrangler CD-ROM comes with several sample Roundup 
files that you can look at to learn how to construct your own 
presentations.    The instructions that follow show you how to create 
your first Roundup    file in the next few minutes.
OPEN A ROUNDUP
1.    Click the Open Roundup button on the tool bar.    It look like this:

Alternatively, you can choose Open from the File menu.    
2.    MediaWrangler displays the Open Roundup dialog box.    The file type that MediaWrangler
automatically selects is .RDP (displayed in the upper left side of the box). 
3.    From the left side of the screen, choose the file titled HOMETOUR.RDP.    Click the OK 
button.

This opens the Roundup file and displays the Home Image,    which is 
a map of the United States.    The filename for this image is 
AKERS.JPG

MAPS AND HOTSPOTS
1.    Move the mouse over the state of California.    Notice that the 
cursor changes to a camera.    This means that there is a picture 
underneath it.    The highlighted area is what we call a MAP  or 
hotspot.
2.    Double-click on this area.      MediaWrangler displays a typical 
California home.
3.    Move the mouse so that the cursor covers different areas of the 
picture.    Whenever the cursors shape changes, it means that you 
can see or hear additional information by double-clicking the left 
mouse button.
4.    You might notice that the cursor changes to a shape appropriate 
to the media that will be displayed.    A camera shape will display a 
picture, a scroll will display a text file, a musical note will play an 
audio file and a clapboard will play a video file.
5.    Double-click on the area over the bedroom window.    
MediaWrangler displays a detailed shot of the interior of the 
bedroom. You can get back to the picture of the front of the house by
using the Navigation Buttons    on the toolbar.
MAKING A MAP
To see how easy it is to make your own MediaWrangler presentations,
lets add a picture to the guided tour of the house.    For this 
demonstration, add a picture of the back yard to the house tour and 
connect it to the sliding glass door in the living room window by 
following these steps:
1.    Move through the house until you come to the living room.
2.    Put the arrow cursor over any corner of the sliding glass door and
press the right mouse button.    The cursors shape changes to a 
pencil.    You are now in MAP draw mode.
3.    Now press and hold the left mouse button.    Move the mouse to 



the opposite corner of the door.    A rectangular box will be drawn. 
When you have the door outlined release the left mouse button.
4.    Single click the right mouse button to exit MAP draw mode.
Now that youve drawn a MAP, youre ready to connect it to a Media 
Element .    One of the easiest ways to do that is with MediaWranglers
Hitching Post .
THE HITCHING POST
From the Hitching Post, you can Drag and Drop    media elements 
(pictures, video clips, recorded sounds, and text files)    into existing 
images in your Roundup file.
1.    Click the Hitching Post button on the toolbar.    It looks like this:

2.    MediaWrangler displays the Open Hitching Post dialog box.    The file type that 
MediaWrangler automatically selects is .HPF.
3.    From the left side of the screen, choose the file titled CALHOME.HPF.    Click the OK 
button.    This opens the Hitching Post file and displays a number of pictures that you can 
choose from to include in your presentation.

4.    Using the elevator bar, scroll down until you locate a picture of 
the back yard. Put the cursor over the picture and press the left 
mouse button, but dont let go. Notice that the border of the 
thumbnail turns red; this means you have selected the image.
5.    Now press and hold the left mouse button down while the 
pointer is inside the thumbnail, then drag the object off the Hitching 
Post.    Youll see the cursor change from an arrow to a picture of a 
camera with a rope leading off from it; this tells you that you have 
lassoed the image from the Hitching Post.
6.    Drag the pointer to the MAP you just drew; when the lasso is 
inside the MAP, let go of the mouse button.    Now whenever you 
double-click on that MAP, MediaWrangler displays the picture you 
just dropped into it.

Thats all there is to it! Making your own multimedia presentations 
with MediaWrangler is just as simple: you draw the MAP, then drag 
and drop your own images into it.



Tips For Building Good Roundups
In the default mode MediaWrangler will manage all memory 
however, options are available that allow maximum performance to 
be achieved.      
It is important to consider what type of Roundup you want to make 
before actually using MediaWrangler to make it. How your roundups 
are structured affects the performance.        Although you can do 
virtually anything, most Roundups fall into 4 categories:
Slideshow
          Slideshow of scenes
          Interactive tour
          Interactive Slideshow
Below are some common structures and the advantages or 
disadvantages associated with them.

Figure 1 shows a good structure for a Slideshow type Roundup.    This
structure gives you the ability to control your timing more accurately
and provides better memory management (see: Helpful Hints ).



Figure 2 shows another structure that could be used for a slide show.    This type structure 
will use more system memory, depending on the size of each image, than the structure in 
Figure 1.    Also this type structure will make timing more difficult due to the variation of 
decompression time on different systems.



Figure 3 is an example of an interactive tour.    Each large rectangle serves as the base 
image of a scene.    By dividing a catalog into scenes the overall process of making and 
editing the catalog is greatly simplified.    In addition MediaWrangler can optimize the 
memory required and thus enhance the playback.    In general each base image will have a 
persistence value equal to the number of image MAPs that are on the base image.



Figure 4 is an example of a slide show of scenes.    This type of Roundup uses a series of 
structures similar to Figure 2.    As the number of elements in each scene increases, the 
adverse effects on memory and timing increase.      It is important to keep the number of 
elements, and more importantly the total size of the files,    per scene to a minimum.    In 
general, an entire scene will be resident in memory at one time therefor allowing time 
consuming decompression to occur between scenes.



Figure 5 is an example of an interactive Slideshow.    This type of Roundup uses a collection 
of structures like the one in Figure 1.    The user has the option to choose which Slideshow to 
view.

Another important thing to consider when making a roundup is the target viewer.    To be 
specific, what type of monitor will your final presentation be shown on.    In general, use 
images that are not too big for the target monitor.    By adhering to this philosophy, image 
quality will always be maximized. 



The Templates
The MediaWrangler disk contains a directory called Template.    The 
Template directory contains some commonly used items such as 
backgrounds, home pages, frames and buttons that you can use in 
your Roundup files.    Quite often, these images will serve as the 
backbone of your roundup.    

The Template directory has sub-directories for frames, buttons, and 
postcards. It is helpful to browse in these directories to get a feel for 
the items available for use.    
For example:    There are a couple of different designs for a 
scrapbook.    If you choose the high tech design for your frame, you 
would want to use the high tech buttons to go with it (of course, you 
can mix and match any of the designs).

In summary, the Template directory contains useful images for 
building Roundups.

How to use the Templates:

To make a quick birthday card, first select the birthday frame you 
want to use.    Draw a MAP and associate a birthday button with it.    
You will want to enable Autoplay for this MAP.    Now call up this 
image by double clicking the MAP and drag it to the appropriate 
location (use the PushPin to set it). Next, draw a MAP on the button.  
Now you can associate a birthday message with this button,    
perhaps in this case you would make a recording of friends and 
family singing Happy Birthday.    Before sending your Roundup to the
intended viewer you should use the Roundup tool to disable window 
frames (you can use the arrow keys to fine tune image placement) 
and enable Auto Autoplay so that the button appears when the 
Roundup file is opened.

 




